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Lighted Print Viewer 

Owners Manual 

 

Cyclopital3D 

Viewer Package Includes: 

• Main Body, Book Viewer 

• Print Holder 

 

• 10 Sample Prints 

• Owner’s Manual 

• CD or flash with two image processing templates 
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Benefits, Features & Specifications: 

• Perfect for modern sized images taken with the Fuji W3/W1 

• Detachable print holder allows easy viewing of standard 4 x 6 prints or 

custom photo books 

• Focus adjustment allows glasses-free viewing for most people 

• Tripod mount for tabletop viewing or handle grip 

• Efficient, white LED lamps provide bright, uniform illumination. Color 

temperature is 5000K 

• Portable, 6 hours of continuous viewing using two AA batteries 

• Stunningly wide 47 degree field of view accommodates ortho-stereo 

viewing for photos taken with the Fuji W3, W1 or other digital camera 

capable of capturing wide-angle stereo photos. 

• Fully coated, precision optics with large achromatic lenses and collapsible 

eye-cups to block stray light 

• Automatic power saving timer turns off lights after 2 minutes 

• Formatting templates included for convenient printing locally or at an 

online print shop or service. Print holder accommodates 10 prints at once 

• Image size is 61mm x 48mm (per side) centered on standard 4 x 6 prints 

with 2mm center spacing.  

• Dimensions: Viewer size 146 x 90 x 115mm (5.75 x 3.5 x 3.5”) WxHxD 

 Print holder 160 x 102 x 23mm (6.3 x 4 x .9”)  

• Weight with batteries: 510g (18oz) 

*Note: not compatible with antique-sized stereo cards 

 

Viewer Usage 

• Insert photos into photo holder 

• Push button on top, right-side of unit to turn 
on the lights (1) 

• Adjust focus as needed to achieve clarity (2) 

• If glasses are needed, eye-cups are 
collapsible 

• To use for photo books, detach photo holder by pushing in two tabs at the 
base of the Viewer (3) 

• Batteries are located at the top, front of Viewer secured with a single 
screw. Rechargeable AA batteries are recommended (4). 

• Clean lenses with optical lens clothes only 

• Attach optional handle grip or tripod as desired for comfort 
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Preparing Your Images for the Viewer 

For best results, it’s important that your prints are formatted and sized properly 
and printed with a printer that utilizes the “Continuous Tone” print process, 
such as the Fuji Frontier used by Walgreens Drug Stores. 

The recommended  formatting procedure is detailed here. The process requires 
that you download two free software programs from the internet, StereoPhoto 
Maker and IrfanView, instructions are given  below. 

Preliminary Set-up: 

• Confirm that you have the latest version of StereoPhoto Maker (SPM), 

v4.32 or newer. If you need a free download or update for SPM, go to                 

http://stereo.jpn.org/eng/stphmkr/  

• Confirm that you have the latest version of IrfanView, v4.28 or greater. If 

you need a free download or update, go to  http://www.irfanview.com/ 

• Create a new folder on the root of your C Drive to be used exclusively for 

your Print Viewer image processing, named: 3D_PrintViewer. Within the 

3D_Print Viewer folder create 3 folders with the names: MPOs, Temp, 

Ready2Print. If you use these exact names, the templates will pre-fill the 

dialogs and make the formatting process easier. 

• Your Print Viewer package includes a CD or flash drive containing two 

image processing templates, “LPV_SPM_Tmplt.mcv” and 

“LPV_IV_Tmplt.ini”; copy the templates into your new 3D_PrintViewer 

folder. The templates can also be downloaded from the Cyclopital3D 

website at http://www.cyclopital3d.com/support/ 

 

STEP 1: 

• Sort your photos and select the MPO files you wish to print. Copy them 

into the MPOs folder you created under the 

3D_PrintViewer folder  

• Start SPM. When it opens, you will see a black screen 

• Click: “File” from top menu, then “MultiConversion…” to 

see dialog box shown on page 4 
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• Click “Restore(File)” near the bottom right of screen and a new, smaller 

dialog box will appear as shown below: 

• Using the “Look in” drop down box, locate the template file: 

“LPV_SPM_Tmplt.mcv” (in the 3D_PrintViewer folder) select it and click 

“Open” to load it and revert to “Multi Conversion” dialog. 
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“Restoring” the dialog from the template file in the last step will populate the 
Multi Conversion Dialog with parameters appropriate for converting MPO files 
from your Fuji W1 or W3 camera to intermediate files that will be further pro-
cessed with IrfanView (shown below). The end result will be .jpg files that are 
ready to be printed by a print service provider (recommended) or possibly on 
your own high quality printer.  Of course, alternate workflow and formatting 
options are possible.  

• In the “Multi Conversion” Dialog change “Look In” to the folder that con-

tains the MPO images you want to format for use in the Print Viewer. 

• The “Output Folder” should be set to the “Temp” folder you created to hold 

the temporary image files that will be generated by this step.  

The fields in the Multi Conversion Dialog should look similar to what is 

shown above.  Note that the “Width” field is set to 1441 and the “Height” to 

1134, this is done for you when you “Restore(File)” but the fields in the dialog 

don’t show the whole numbers, the LS digits are hidden. 

• Click the “Auto alignment Setting” button and set the window adjustment 

field in the dialog box, as shown on next page (6). 
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• From the drop down list, select “Input the deviation(%) of the image width” 

and also set the value to 3.5% as shown below. Important: Performing Auto 

Alignment on the MPO images will set the spacing of homologous “far 

points” in the prints to the proper distance for the Lighted Print Viewer.  

• Note, If images were taken using the Cyclopital3D Auxiliary Lens Adapter, 

you may want to check the box to “Correct barrel distortion” and set it’s 

parameter appropriately (value is dependent on which lens was used with the 

ALA, for Raynox HD-5050 set value to 35). 

• Click “OK” to close Auto Alignment Setting dialog and revert to “Multi 

Conversion” dialog box.  

• Click “Convert All Files” and wait for the conversion process to complete. 

Note; if “Multi Job” was checked you will see two processing dialogs, this is 

normal. The “Multi Job” will use two cores of a multi-core processor and 

image processing will complete twice as fast. 

• When image processing is complete, exit the processing dialog(s) and close 

SPM. Proceed on to step 2. 

IMPORTANT!!! Unfortunately, the actual value for the percent deviation is 
not stored in the .mcv file, so you MUST SET the percentage value in the 
Auto alignment setting dialog before you start the batch process in SPM 
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STEP 2:  

• Start IrfanView  

• Click: “File->Batch Conversion/Rename…” 

to see screen shown below: 

• Set the radio button under “Work as” to “Batch conversion” 

• Set “Look in” to the directory that contains the temporary image files 

generated by SPM in the previous process. (“Temp” under 

“3D_PrintViewer”)  

• Click “Add all” and all the images will be added to the “input files” list at 

the bottom of the page. 

• Set the “Output directory for result files” to the folder you created 

“Ready2Print.” This folder will contain the image files you will take or 

send to your print service provider. 

• Make sure the box for “Use Advanced options for bulk resize…” is 

checked. 
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• Click “Advanced” under Batch conversion settings”, you will see the “Set 
for all images” dialog  

The “Batch conversion settings” should be set as shown above- don’t worry; 

you don’t have to set any of this stuff yourself.  

• Click “Load Settings” (lower left) and browse for the template file:  

“LPV_IV_Tmplt.ini” and open it; this will populate the variables in dialog 

box. This file should be found in the 3D_PrintViewer Directory you created. 

The important parameters in this box are the “Settings” for the canvas size and 

the value for DPI. This step centers the image on the print “canvas” and fills 

the borders with black.  

• Click “OK” to close the “Set for all images” dialog and revert to the “Batch 

conversion” dialog. 

• Click “Start Batch” in the “Batch conversion” dialog. 

• When the process completes you are finished, click “Exit batch” and close 

out of IrfanView.  

• Delete the temporary image files (all files in the “Temp” folder under 

“3D_PrintViewer”) created by SPM 
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STEP 3: 

Transfer the finished print files to your print service provider and have them 

printed on 4X6 inch glossy paper. Be sure your print service provider is using a 

“continuous photographic process” and not ink-jet or screen printing to make 

the prints; otherwise you will see “pixels” in the prints.  

If the prints are made with a Fuji Frontier printer you can be assured they are 

using the right process. We know Walgreens uses this process, others do as 

well. Please check our web site for an updated list of print service providers 

that use a continuous photographic process to make 4X6 prints. 

Note: Edited photos or .jpg files can be formatted for use with the LPV using a 

similar process. Read advanced Concepts for a more detailed explanation. 
 

 

Advanced Concepts: Image Formatting 

In the previous section we provided step by step instructions for formatting 

MPO files from a Fuji camera for the LPV. There was no explanation of “why” 

you were doing what you were doing, just how. This section will explain the 

theory behind the process and provide instructions for printing from various 

other (Non-MPO) stereo image formats. This assumes that you already have 

digital stereo photographs on your computer that you wish to print and that you 

are somewhat familiar with the operation of StereoPhoto Maker (SPM). The 

actual process will be similar to what was described previously in the step by 

step instructions however, depending on the format of your source images you 

will need to make a few decisions and change some of the settings in SPM 

from the values contained in the supplied image processing templates. When 

you get things set up the way you want them you can save your own SPM and 

IrfanView (IV) templates to make future processing easier. 

You may be able to use the step by step procedure “as is” or with very little 

modification if all you are doing is processing a different image storage format. 

For example, if your sources are parallel side-by-side images in .jpg format 

you can use the procedure directly with no change, just use the .jpg files in 

place of the .mpo files. Similarly, if your source images are cross-eyed side-by-

side jpg files, all you have to do is select the "cross" radio button in the "Auto 

alignment setting" dialog, AND check the box "Swap Left/Right" in the "Multi 

Conversion" dialog, everything else remains the same. If the aspect ratio of 

your stereo files is much different from 4:3 or if you are interested in the 

theory of mounting prints for a stereoscope, then please, read on. 
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The Image Size: 

Printed images for use with the LPV are formatted as side-by-side pairs, with 

the left eye image on the left side and the right eye image on the right. The size 

of the image for each eye is the same, with the maximum viewable area being 

61mm wide and 48mm tall. There is an area 2mm wide between the right and 

left images, the “septum,” that cannot be seen with the viewer. This area, 

which separates the right and left images should be black. The image pair 

should be centered horizontally and vertically in the 4X6 print “canvas,” and 

the “borders” around the image should be black. 

The step by step process formats Images for printing with a file “resolution” of 

600 dpi, which results in a “chip width” of 61mm consisting of 1441 “dots” or 

“pixels,” (chip means one side of the pair, either the left or right image). The 

vertical dimension is 48mm or 1134 dots, which is why the “re-size” 

parameters in the “Multi-conversion” dialog are set to 1441 by 1134. 

The space between the chips is set by the value of the “L/R Space(Only Print/

Save available)” option in the “View->Border Options” dialog. This is a little 

obscure because you might expect to find the parameter in the “Multi 

conversion” dialog itself, but it’s not. Fortunately, the value is stored in the 

processing template (.mcv file) and set when the “Restore(File)” option is used 

in the “Multi conversion” dialog. 

Infinity Spacing 

The lenses of the LPV are separated by 65 mm. Therefore the “infinity 

spacing” (far point spacing) of homologous far points in the right and left 

images should also be 65mm (or slightly less). If the far point separation is the 

same as the separation of the lens axis, then there is no need for an interocular 

adjustment on the viewer. This is a result of the “prismatic effect” of the lenses 

which exactly compensate for use “off axis” by persons with eyes that are 

spaced narrower or wider than the lenses. Instead of having an interocular 

adjustment, large lenses are used to accommodate a wide range of users eye 

spacing however, for this to work well the images MUST be formatted 

properly (with the correct “far point spacing”). 

If an image pair has a far point spacing that is larger than the lens separation 

(65 mm), the user’s eyes will have to diverge in order to fuse the cyclopean 

image (the 3D image seen by the “mind’s eye”); this should be avoided 

because it can cause viewing discomfort and may even make the image 

impossible to fuse. You can use a ruler to measure the far point spacing in a 

mounted pair.  
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First, find the object that is furthest away in the scene, then select a point on 

this object in the left image and measure from this point to the same 

(homologous) point on the same object in the right image. If the print is 

properly formatted for the LPV this distance will be 65mm or a bit less. 

You can use the “Auto alignment” function in SPM to achieve a constant 

infinity spacing for all the images processed in a batch which is why the “Auto 

alignment” option is selected in the step by step process. With the auto 

alignment parameters set to: “Input the deviation(%) of the image width” and a 

value of “3.5%” the result is an infinity spacing in the re-sized mounted pairs 

of 65mm (61 mm + (3.5% of 61mm = 2mm) + 2mm septum). 

The Aspect Ratio 

One big difference between MPO files from a Fuji W1 or W3 and other stereo 

formats is that MPO files from a Fuji camera generally have an aspect ratio 

that is close to that of the LPV (by design). However, the aspect ratio of a 

stereo image is really a matter of artistic choice of framing. Even though your 

camera may produce images that have an aspect ratio of say 4:3, you can 

always crop the images to be whatever you like. You are not limited to the 

specific aspect ratio of the LPV. However, if the aspect ratio of your image 

does not match the aspect ratio of the LPV, then some of the viewable area 

will be black. In this case an image may show “full width” but not full height, 

(with “black bars” top and bottom), where others may show full height but not 

full width (with black bars on both sides). 

The native aspect ratio of the LPV is 61:48 (pretty close to 4:3). If your images 

have an aspect ratio that is much different then you have 3 choices: 

1. Let SPM automatically crop the images to match the aspect ratio of the 

LPV. This cropping is what happens in the “step by step” process, 

because the “Crop” option is selected in the “Multi conversion” dialog. 

The images are cropped symmetrically, top and bottom, or left and right, 

whichever is required. If the source images are MPO files from a Fuji not 

much is lost. Note, in this case a “vertically oriented” image will have a 

lot cut off the top and the bottom to turn it into a “horizontally oriented” 

image to match the viewer. 

2. Manually crop each image to match the aspect ratio of the viewer. This is 

similar to option #1, but you make the choice of what to crop out instead 

of just taking the “center” of the image. Obviously, if you crop manually 

then you must crop each picture individually, it's a bit more work, but it's 

probably worth it.  
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The Aspect Ratio (cont.) 

2. (Cont.) To crop an image manually use the "Free Cropping Option..." 

from the pull down on the crop tool in SPM. Make sure "Keep Aspect-

ratio” is checked and set the Aspect-Ratio is 61, 48. Crop the image and 

save it as a stereo side-by-side image, being careful about your current 

"viewing" mode; if your viewing mode is cross-eyed then a cross-eyed 

image will be saved and this may or may not be what you want. Once 

the aspect ratios of all your images match the viewer, you can batch 

process them for printing using the same parameters as described for the 

MPO files. 

3. The last option is to let SPM automatically add borders around your 

images to maintain the aspect ratio of the sources. To do this simply 

select the “Border” option instead of the “Crop” option in the “Multi 

conversion” dialog in the step-by-step process. Note that the color used 

for this border is the background color of the SPM photo viewer. If it’s 

not already black, you should set it to black before you start batch 

processing. If you’re wondering, the “Absolute” option (next to the 

“Border” option) stretches each axis of the source image to fit the output 

size, which probably isn't very useful because it can severely distort the 

image by making the X and Y scales different. 

If you want some images "cropped" and some "bordered" or you have some 

cross-eyed sources and some parallel sources, you must batch process the 

pictures of each case into the "temporary files" as separate batches. All the 

temporary files will end up the same size, in side-by-side parallel format, so 

you can batch process all the temporary files using IrfanView (as described in 

the step by step process) from all the source variants in one go. 

The purpose of the step that uses IrfanView is simply to center the (temporary) 

images created using SPM in a 4X6 “Canvas” and to fill the outside borders 

around the image with black. Note, the parameters loaded into IrfanView from 

the supplied template also scale the image down by 1% before the border is 

applied. This is to make up for the 1% growth most print services apply to 

make sure the image fills the print edge to edge. This can be changed if your 

print service provider uses a larger number, but if you change the percentage 

you also have to change the “Canvas Size” border settings. The end result 

should be an image that is 3600 pixels wide and 2400 pixels tall. 
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The Stereo Window 

The stereo window is an important concept in stereoscopic viewing 

experience. If you don’t already understand what the stereo window is and 

why it’s important, you should take some time and look it up on the internet. 

 
Although it’s technically possible, SPM does not have a UI mechanism to set 

the stereo window position independent of the far point spacing. However, if 

the far point spacing and image width are constant, then distance from the 

observer to the stereo window will also be constant. When you use the 

procedure described in the step-by-step process, the stereo window is set to be 

about 6 feet in front the camera and is perceived to be closer if the far point is 

closer than infinity. This window position also matches the “natural” stereo 

window of the LPV. 

Although SPM does not have a UI method to set the window position 

independent of the far point spacing, it can be done when batch processing by 

manipulating the parameters for “Auto alignment” and “Multi Conversion.” If 

the method for setting the stereo window in the “Auto alignment Setting” 

dialog is set to “Input the deviation(%) of the image width,” the percentage 

value specified can be thought of as the maximum amount of deviation 

allowed in the image if all the objects in the image are to remain “behind” the 

stereo window. It’s OK for an image to have more deviation than this if the 

parts of the image that end up in front of the stereo window do not intersect 

the sides of the frame, then there is no “window violation.” However, if the 

image has more total deviation than is defined by the “% deviation” parameter 

AND the near objects intersect the image frame, then there will be a window 

violation. Because the view is so wide in the LPV, a “window violation” may 

or may not be troublesome; if it is, there are several ways to fix it, as explained 

below: 

1. You can crop the image to reduce the total deviation to less than 3.5%. 

This probably means trimming off the foreground (bottom). 

2. You can make the border “fuzzy” so there are no hard edges to make a 

window frame 

3. You can move the stereo window back (towards the observer) by 

cropping a little off the outside vertical edges of the mounted pair.  
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The Stereo Window (cont.) 

 

If you want to move the window back by cropping off the outside edges, open 

the finished image (from the directory “Ready2Print”) in Irfanviw and select 

“Image->Change canvas size...” you will see the following dialog: 

 

 

 

 

 

 

 

 

 

 

 

 

Make sure  “If negative values used: add canvas to inside” is checked, and that 

the “Border color:” is set to Black. Negative values for “Left side:”, “Right 

side:”, “Top side:” and “Bottom side:” will add borders from the outside of the 

print inwards, leaving the overall canvas size unchanged. We want to increase 

the size of the existing borders on the left and the right by a little bit in order to 

move the window closer. The side boarders are already 350 pixels wide, so to 

crop 2mm off of each side of the image in the center we would add 47 pixels, 

(2mm @ 600 dpi = 47 dots) making the side boarders -397 pixels wide. We 

don’t want to change the image vertically, so the “Top side:” and “Bottom 

side:” parameters should be set to 0. Press “OK” and the image will be 

cropped, save it and it’s ready to be printed. 

 

 Exactly how much you need to move the stereo window back of course 

depends on the image. Cropping 2mm from each side as described above will 

allow for a total deviation of about 5%, cropping 4mm from each side (-444 

pixels) will allow for more than 7% total deviation. Any more than this and 

you are probably pushing the limits of “comfortable viewing”. 

 

If you got this far I congratulate you on your tenacity. It’s possible I've been 

too explicit in my instructions for image formatting. Basically you just need to 

make the stereo pair fit the front opening of the viewer. That's really about all 

there is to it, for the most part everything else just falls out naturally. 

                                KenKenKenKen    
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Viewer specifications: 
Overall dimensions: Width : 146mm, Height : 90mm, Depth: 115mm 
Weight: 510 grams 
Tripod Mount: Stainless Steel insert, ¼-20 threaded hole 
Image “chip” size: 61mm X 48mm per side 
Chip separation: 2mm 
Lens separation: 65mm 
Lens focal length: 70mm 
Lens diameter: 34mm 
Lens type: Achromatic doublet, with anti-reflection coating on both sides 
Eye cups: Elastomeric, fold back for use with eyeglasses 
Maximum Horizontal Field Of View (HFOV): 47 degrees 
Maximum Vertical Field Of View (VFOV): 38 degrees 
Focus System: Rack and Pinion 
Focus range: +2 to -1 Diopters 
Eye Relief: 2mm 
Distance from observer to the “Natural” Stereo Window: 7.5ft (2275mm) 
 
Lighting System: 
Power Source: Two AA batteries, NiMH recommended 
Battery Life: Six Hours of light between charges 
Emitters: Ten high output white LEDs 
Color Temperature: 5000K, near black body spectrum 
Operation: Press button to turn light on, auto off, 2 minute timer, timer can be 
reset by pressing button. 
 
Print Holder specifications: 
Overall dimensions: Width : 160mm, Height : 102mm, Depth: 23mm 
Weight: 96 grams 
Print size: Standard 4X6, 4 inches high (102mm) by 6 inches wide (152.4mm) 
Print Capacity: 10 prints 
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All rights reserved, Cyclopital3D, Inc. 2010 

Caution: this is a delicate precision product and should be treated with the 
same care given to any fine camera or lens. Do not apply excessive force to the 

focus mechanism or the print holder when removing or a$aching. 

Care and Maintenance 

Cleaning: use an optical grade lens cleaning cloth. Do not spray liquid directly 
onto the Viewer and avoid getting any moisture in any openings. 
 

Product Warranty 

The Cyclopital3D Lighted Print Viewer comes with a 90-day warranty against 
manufacturing defects in material or workmanship. It is warranted for normal 

Formatting & Printing Services Available! 

Too busy to format and print your own photos? Let us do it for 

you! Cost is only $1.00 per photo, plus $5 shipping and handling.  

 

Simply send us a flash drive with the raw MPO images you 

wanted printed to: 

Cyclopital3D 

323 S. Washington Ave 

Fort Collins, CO 80521 

 

Include your phone number or email address with your order 

details and we will call or email you to confirm your order and 

payment preference. Payment are accepted via check, Paypal or 

credit card. Your photos will be mailed to you within 5 days of 

confirmation communication. 

 

For processing of edited or .jpg images, an additional processing 

fee may apply.  Also, please indicate if photos were taken using a 

Cyclopital3D Adapter, which model and if an auxiliary lens was 

used. 


